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Kilka stow o nas TRENER*’*!%

CONSULTING

istniejemy od 1991 roku
realizujemy projekty z zakresu szeroko rozumianej Geoinformatyki
szczegolnie interesujgce nas dziedziny, to:
LiDAR
Systemy Informacji Geograficznej (GIS)
Globalny System Pozycjonowania (GPS)
fotogrametria cyfrowa
fotointerpretacja
teledetekcja lotnicza i satelitarna
klasyfikacja obiektowa (OBIA)

technologie informatyczne w stuzbie ochrony przyrody i Srodowiska
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SEENEREES
System satelitarny RapidEye
5 satelitow
wysokos¢ orbity 630 km
4 miliony km? dziennie , ,
liczba satelitéw 5
czas rewizyty 1 dzien
//’ inklinacja do réwnika 97,8
2 zakresy podczerwieni RapidEye
Delivering the World okres rewizyty 1 dzien
czas okrazenia Ziemi 96,7 min
rozmiar piksela terenowego 5m

/obrazowania satelitarne

G E Ol

“Blue’” -B
“Green” -G
“Red” - R
““Red Edge” - RedEdge

“Near Infrared” - NIR

Sensory — zakresy spektralne kanatéw [nm]

440-510
520-590
630-690
690-730

760-880
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@ Trimble

it}

2 geCognition’*’

The Earth to Business Company

& esri

7Terrc|so||c|

processing laser and images

LP 60

— FUr ArcGIS®

Oprogramowanie, ktérego uzywamy

Trimble eCognition — oprogramowanie do klasyfikacji

obiektowe]

Leica erdas — wiodgce na Swiecie oprogramowanie do analiz

zobrazowan teledetekcyjnych

ESRI ArcGIS — oprogramowanie do zarzadzania, analiz

i wizualizacji danych

Terrasolid — oprogramowanie do zaawansowanych analiz

danych lidarowych

QCoherent LP360 — rozszerzenie oprogramowania ArcGIS

do analiz danych lidarowych
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N4 Przebieg webinarium TRENER ts

ProGea 3

Fotografia jako informacja geograficzna
Pozyskiwanie dodatkowej informacji z fotografii
Fotografia w oprogramowaniu ArcGIS
Rozwigzania serwerowe

Przyktady zastosowania

Odpowiedzi na pytania

Opisujemy nieopisane...
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Fotografia jako informacja ;:gggN@;5

Jeden obraz mowi wiecej niz tysigc stow,

Jjedna mapa méwi wigcej niZ tysigc obrazow.
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GPS-Photo-Asset Management TRENER £

CONSULTING

Urzadzenia

Oprogramowanie
7 : -1 Exif
G700sE » Exif Extractor OJ Extractor

» PhotoMapper Desktop

a® »))
€3 Bluetooth’ ¢ )
\ r

» PhotoMapper Server
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Co to za miejsce ?
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Co to za miejsce ? IRENERP{°°==<

ProCca

Zarzadzenie i geolokalizacja dokumentacji fotograficznej 10



) :
& Fotografia TRENER 2
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Co rozumiemy pod pojeciem fotografii?

e obraz
o charakterystyka sprzetu
* mozliwosc okreslenia okolicy, w ktérej fotografia byta wykonywana

Co jeszcze? Plik zdjecia
it ., N
* potozenie | e Al
* kierunek wykonania zdjecia | s/ 5_\9_2%: .2
* opis fotografowanego obiektu | PR { | ik
| ' |
 klasyfikacje fotografowanego obiektu (np. :!hé»; . »‘: 4
zaklasyfikowanie do okreslonej grupy : J B Informacje
obiektéw, jak rosliny chronione, infrastruktura : EXIF : dodatkowe
turystyczna) B s g gy il

° autor
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Co to jest EXIF?

Przyktady informacji zawartej w naglowku EXIF

¥ Camera (123)

Make

Camera Model Name
Exposure Program
Metering Mode
Flash

Focal Length

Image (60)
File Name
Directory

File Size

File Permissions
File Type

MIME Type
JFIF Version
Resolution Unit
X Resolution

Y Resolution

WB RGGE Levels Flash

Color Temp Flash

Raw Measured RGGB

Custom Picture Style File Name
Focal Plane X Resolution
Focal Plane Y Resolution
Focal Plane Resolution Unit
Exposure Mode

White Balance

Scene Capture Type

altag

Canon

Canon EOS-1Ds Mark III
Aperture-priority AE
Multi-segment

No Flash

38.0 mm

IMG_2254.3°G
D:/Kuba/inne /do_konferency,
792k8

WIWLw-

PEG

image/ipeg

1.01

nches

%

%

5079 2089 1024 1024
1538
08191 16785407 16777897

1961.945032
1964.021164
inches

Auto

Auto
Standard

v Time (21)

File Modification Date/Time

Modify Date
Date/Time Original
Create Date

¥ Location (30)

GPS Version ID
GPS Latitude Ref

GPS Latitude

GPS Longitude Ref

GPS Longitude

GPS Altitude Ref

GPS Altitude

GPS Satellites

GPS Img Direction Ref
GPS Img Direction

GPS Map Datum

GPS Dest Latitude Ref
GPS Dest Latitude

GPS Dest Longitude Ref
GPS Dest Longitude

*csv *axml *kml *kmz *.shp *.shx *.prj *.dbf *.pdf
GPS Img Direction Ref True Morth
2010:06:20 17:10:10+02:00  Image Width 2048
2010:05:23 16:19:11 Image Height 1366
2010:05:23 16:18:11 Encoding Process Baseline DCT, Huffman coding
2010:05:23 16:19:11 Bits Per § ) 8
Color Components 3

2.2.0.0 Country Poland

Morth State Mazowieckie

52 deg 31' 52.68" GPS Altitude 685 m Above Sea Level

East Province-State Mazowiedkie

19 deg 39 43.97° 2”‘3*"?“” t“‘z Soge S EOL

ountry-Primary Location Name Poland
== Sub-ocation Brwilno Nowe

685m City Plock

0

True North ¥ Other (5)

21.35 GPS Latitude Ref North

WGS-84 GPS me Ref East

North Application Record Version 4

. . Keywords Mazowieckie, POL, Poland, Brwilno Nowe, Plock
SRS Caption-Abstract Widok z lotu ptaka na Phock. Kierunek NNE.

East
19 deg 40° 41.63"
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Aparat + GPS + stownik
Azymut, kierunek
A

350R24INNW/m'ag

Wspélizedne EXROR 915654
geograficzne GNEO3 5345074285
o
— ,
Ilo$¢ uzywanych / |
satelit

==

Informacja o
sygnale GPS

! N\

dokladno$¢ Ilos¢ widocznych satelitow

%&m«u)

F

Brak sygnatu
GPS
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List Editor TRENER i

Lizt Editor - slownik_expo_ProGea.mta _ Elﬂlg

File Edit Tools Help ___czyli proste zarzqdzanie

D& e e N i
TSR, zdjeciami cyfrowymi i ekstrakcja
danych zapisanych w pliku EXIF

Enter the item name and settings.
budynki l maka architekiura ru:us'linnc:éé] Itemd ] [tema ] ItemB ] [tem? ] [tem3 ] lhe 4 | *

[termn Mame:
|I:uuu:|_l,lnki

Details:
[ FipLat;

Input Lizt:

Edit

mleszkanluwe
szkoky

kiozki

Expo

zklep

g Czytanie informac;ji
takze z kodéw kreskowych

Cromn I

A

Delete

dlls
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"o | Exif ...czyli proste zarzadzanie zdjeciami cyfrowymi i
Extractor  ekstrakcja danych zapisanych w pliku EXIF

plik EXIF

*csv Foml *kml *.kmz *.shp *.shx *.prj *.dbf *.pdf

+ zapis parametréw GPS, kompasu i aparatu (informacji z pdl MEMO)
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o-| Exif
Extractor

Exif Extractor

...czyli proste zarzgdzanie zdjeciami cyfrowymi i
ekstrakcja danych zapisanych w pliku EXIF

Przyktady wygenerowanych plikow

KMZ

RIMG0182.JPG

DRIMG0182.JPG

Lalitude:  47,777803"N
Longitude: 11,299411*E
Atttude:  327m
Direction: 67,7*
[ o] i § - 1447
RIMGO188 JpGE Timestamp:26 wizeénia 2008 - 14:47:43
Memos
tree
car
people:
animals:cow
house

KML created by "Exif Extractor NG” (wyawaltad com)
Instrukeje dojazdu: Do mieisca - Z mielsca

-Google

Wys. widok

4481/st6p

RIMG0179.JPG

Longitude:11,3032527777778
Altitude:469

Image Direction:1,1

Datetime Original:2009:09:26 14:42:11
Image Make:RICOH

Image Model:Caplio S00SE

Longitude:11,2994111111111
Altitude:327

Image Direction:67,7

Datetime Original:2009:09:26 14:47:43
Image Make:RICOH

Image Model:Caplio S00SE

RIMG0188.JPG
o

Longitude:11,2995333333333
Altitude:99

Image Direction:173,7

Datetime Original:2009:09:26 14:56:53
Image Make:RICOH

Image Model:Caplio S00SE

RIMG0210.JPG

Longitude:11,2917388388889
Altitude:590

Image Direction: 167

Datetime Original:2009:09:26 15:23:30
Image Make:RICOH

Image Model:Caplic S00SE
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PhotoMapper Desktop

CONSULTING

"o ] PhotoMapper .. czyli bardzo wygodne i skuteczne zarzadzanie
P Desktop ($rodowisko ArcGIS 9/10)

i File Edit View Bookmarks Insert Selection Tools Window Help

[DsEs:2ax|[o~[sFEm (4| &80R R | RRBEE0E B ] BE || eep <@
il = U Editorv| * | # > Task: [Create New Feature = | Torget: | Hxeaaa | @At 4%k |0o \
Georeferencing v | Laver | o G > A ‘ & oo ‘E = J Layer: [ shp_1 JEd ¢ I = o0 = ‘
<@ L o RPN R % « 3
E shp_1 % :t :
shp9210000 a
Krakéw - zdjecie lotnicze b3
&
® 7, i
: : V> : : { Kierunek
1 PP N ) A T ¢ msaep| wykonania
: ; 2y W ; ‘ zdjecia
DODATKOWO: °
MOZLIWOSC :
TWORZENIA &
RAPORTOW =
PDF )
e <] Wysokosé 25 Atrybuty opisowe (dowolnie

B FID | Shape, lat_ref It_ref | img_dir date_org distang - 5, - = - -
0 | Point 50.049619 | 19.953017 N 214 35 | 2010:10:11 12:42:01 obiekt wiadukt drogowy | droga krajowa material zelbeton
1 | Point 50.0482 | 19.954689 5 N 222 329 (2010:10:11 12:39:12 obiekt most kolejowy droga - material zelbeton
2 | Point 50.041 | 19.962556 s N 190 262.5 | 2010:10:11 12:01:35 obiekt kladka dla pieszych | droga lokalna material zelbeton
<

] ' /

Display ISuuroe l peecon I Mopioo I Record: ﬂ j 1 _»] :] Show: W Selected Records (0 out of 5 Selected) Options ~

| Drawing v K () @ \ [N AT i \ ,———————————————
| [569386.619 243409411 Meters i
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Rozpoczecie pracy

Rozszerzenie ArcGis 9/10

“ Untitled - ArcMap - Arcinfo ArcPad FEX
ArcScan e —
Eile Edit View Bookmarks Insert Selection Tools Window Help OGO
=& B + Cadastral Editor (%4
Edkor v| M | # ~ l ;, Data Frame Tools :l X =Rl
Dimensioning
* @ Distributed Geodatabase =
Layers
Q v  Draw
EH v Editor
3 Effects
R a5
) GPS PhotoMapper NGZ Toolbar
G Geocoding
=2 Geodatabase History
K Geometric Network Editing
= Georeferencing
k Geostatistical Analyst
o Graphics
Labeli
4 ing
e Layout
);Y Map Cache
? Network Analyst
. . Parcel Construction =]
X -
Display | Source | Selection X IERY Publisher |>|—
i Raster Painting
Drawing ~ K () &@ - - . - Sv Sv o
* ed - Archap 5
File Edit Yiew Bookmarks Insert Selection Tools ‘Window Help
BEHS|: BBX[o & BEEAr LY =F S
Ed\m['| [ 3 | & v Task ICrsate New Feature j | TaI’GEt:I LI ‘
= -
_gm— @ GPS PhotoMapper N... [X] I
Q| lm | W ‘ @
e
r
ma
<
¥
A B
Display Selection 20 204 >
Qrawwng'k®|D'A'E|l@AnaI ;Ilm;l B I g|£v
| |231,15 986,403 Unknown Units A

G E Ofe¥

JIRENERPw s

PhotoMapper
t:,j Desktop

oo 2l NI =5
Import IThurnbnaiI Cachel
r—Include EXIF information
GPS | Image I Camera |
v Latitude
¥ Longitude
V¥ Altitude

AltitudeRef
¥ knage Direction -
¥ Jmage Direction Ref

[~ Satellites
[~ popP
[~ Speed

— Extended import settings
¥ Use absolute path

" Use relative path
—Settings direction
Auto

Value for direction is selected aomatically (default setting is compass;
if compass value is 0, the moverghent direction is used).

Set to default

Nie zawsze wszystkie informacje
sg nam potrzebne — mozliwos¢
wyboru
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Rozpoczecie pracy

i@ Untitled - ArcMap - ArcInfo
J File Edit View Bookmarks Insert Selection Tools Window Help

Look in: I[:I roboczy j EI Qlalgl l_

JDD’“E§|&EX|nm|¢/“1:ﬂ.m 'IHQ|@%EI:D-|R?‘
Editor * ¥ Task: | Create New Feature 4 arget: -
=74 cv| & | # > Task [Create New F Targ e
x| = x = NS T TN
& “d GPS PhotoMapper N... a N
E_gm Q Menu - - T S =
krakow_granica - m | oo o | o 8
ERy o .
O arkusze TOPO H » | 3 New shapefile Ctrl+N
M-34-64-D-d-1-1ti | 23 Edit 4 | Mew File Geodatabase
M-34-64-D-d-1-2. {“’7 View 4 Add new Feature Class to existing File Geodatabase
M-34-64-D-d-1-3.4 0 Tools L4 ﬁ Open Feature Class Ctrl+ O
M-34-64-D-d-1-4.ti .
M-34-64-D-d-2-1.ti ‘ Srver ' Import PhotoMapper 2.0 Feature Class
M-34-64-D-d-2-241 | ) ||| @ Service v -
M-34-64-D-d-2-3 | | ;g photos
mozaika_cala_re.tif Add photos from folder
unreferences otos
Add unreferenced ph
; Update Exif in image files
#h
-]
Y

a geobaza_Krakow.gdb
5 geobaza_l.gdb

Name: |geobaza_caly_Kmkow_2

Save as type: IFiIe Geodatabases

PhotoMapper
g Desktop

Praca na plikach SHP

Mame for Feature Class:
Iirrflastruktuva

| Ok || Cancel
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@fﬁ

Wyswietlanie danych TRENER b

'U

ProCca

"o-]PhotoMapper
IRl Desktop

Merw  Tourism s

en\RIMGO018.JFG

S E

Btedne potozenie punktu moze wynikac z:

* Nieprawidtowego uktadu odniesienia (coordinate system) lub elipsoidy
(datum);

* Nieprawidtowym nadaniu potozenia punktu bez georeferencji;
e Stabego sygnatu GPS podczas wykonywania fotografii;

* Braku geoodniesienia danego punktu.

Zarzadzenie i geolokalizacja dokumentacji fotograficznej 20
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J File Edit View Bookmarks Insert Selection Tools Window Help

4 proj_2_3 - ArcMap - Arclnfo

DEE& & =2BX| oo $|[2m j|£|@&m=}.|~?‘
.4 R@ U Edito;v| [ 3 | , - Task:ICreate Mew Feature ;I | Target:l LI |_>(
@ & i e— o
of
1 £ Layers @ Meru - | infrastruktur - 3 8 —
=] infrastruktura -
L= ew Shapefile
el Bt Fil > New Shapefil
krakow_granica e Edit 4 Mew File Geodatabase
O arkusze TOPO & View » Add new Feature Class to existing File Geodatabase
7 M-34-64-D-d-1-1 ¢
m :: z g : i ]Z-EI: 0 Tools * |[E5 Open Feature Class Ctrl+0
M-34-64-D-d-1-34if | €0 ||| Se""_e’ ' Import PhatoMapper 2.0 Feature Class
M-34-64-D-d-1-4tif | mh @ Serice  » dd o
M-31-64-D-d-2-14F | |y photos
M-34-64-D-d-2-2 tif Add photos from folder
M-34-64-D-d-2-3.4if | Add unreferenced photos
O mozaika_cala_re.tif [ Y
1]
Ak

Dodawanie zdjec bez georeferencji

PhotoMapper
Desktop

Obrazy z nagtéwkiem EXIF,

J File Edit View Bookmarks Insert Selection Tools Window Help
BT Sy [l e
IJ W EE U Editolv| 3 | & = Task ICreateNeerature ;,| Target:l
Y /
= S C] GPS PhotoMapper N...
] Layers = Menu ~  infrastruktur ~
= infrastruktura ﬁ B0 GPSLOG ’E| ORI |E @ |
L ] I 2 @ kopia
krakow_granica 3] &3 orto 0
O arkusze TOPO am E--@ zdj
M-34-64-D-d-1-1|= &2 bef_geotagu
M-34-64-D-d-12 | | @ B0 2 kr_rome -
M-34-64-D-d-1-3 || fie | fps-exif |
M-34-64-D-d-1-4 | | wp || RIMGOODTipg s
_34-64-D-d-2- 1 : yes
M-34-64-D-d-21) Il p | RiMGODD3jpg yes i
1-34-64-D-d-2-2 " || RIMGODDS JPG yes
M-34-64-D-d-2-3 RIMGOD07 jpg Yes
ika_cala_ret ™ YR ' yes
¢|:|D A AT RING0Z18.PC yes
Display | Source I l =l jpg o
Selecti (.
ion | Map Book 20 |
o

Zarzadzenie i geolokalizacja dokumentacji fotograficznej

niekoniecznie z nadanym
geoodniesieniem

Obrazy bez nagtowka
EXIF (wykonane
zwyktym aparatem
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Dodawanie zdjec bez georeferencji {@RE_NERM

ProCca

CONSULTING

"o ]PhotoMapper

> Desktop —. Nowa warstwa (np. z tej samej geobazy)
_ , 6"'): = Sliean x| automatycznie widoczna w PhotoMapper Desktop

@ proj_2_3 - ArcMap - Arcinfo
File Edit View Bookmarks Insert Selection Teols Window Help

 infaciraktore [ |oswaimex|o s |4 een:
| w’@“ Edito;'| = |’ ~ Task:lCreateNeerature{' ;I |Target:|

= & GPS PhotoMapper N..

= infrastruktura B Merule ’mﬂ =
e u infrastruktura ’i| Bo < | &
krakow_granica n W
O arkusze TOPO 52 § B oo ]
M-34-64-D-d-1-1) | | g, B0
Name: |innejunlﬂy_Kr ..@ bez_geotaqu
m W M-34-64-D-d13 || D B zdi_Krrome >

Show of type: IDatasets and Layers (“h)

@ proj_2_3 - ArcMap - ArcInfo

File Edit View Bookmarks [nsert Selection Tools Window Help

|DsE&E|: @Y oo |d[mew OO
| ﬂ!]@” Edito['| 3 ‘, - Task:ICreateNeeratura LI | Target:l

15

GPS PhotoMapper N...

Menu - infrastruktur -~
B GPSLOG ,i| Gz 4 ‘ @ 8
@ lopia N
@ arto
B0 zdi
{) bez_geotagu
) 2di_Kr_rozne

= infrastruktura -
[ ]

krakow_granica

O arkusze TOPO

M-34-64-D-d-1-1

M-34-64-D-d-1-2|

M-34-64-D-d-1-3

O X ¥ ER-REE X FelRt¥oycl

M-34-64-D-d-1-4 file: gps-exif
M-34-64-D-d-2-1 Emgggg;!pg yes
g yes
M-34-64-D-d-2-2 Acooce ] v
M-34-64-D-d-2-3 RIMGO006.JPG yes
O mozaika_cala_re.t RIMGD007 jpg yes
o RIMGD010jpg yes
. = T RIMGO212.JFG yes
RIMG0226.JPG yes
Display Source no

Selection Map Book I

Ustawianie punktu w odpowiednim
potozeniu

Dodawanie zdjecia bez
georeferenc;ji
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Podglad zdjecia i atrybutow

CONSULTING

PhotoMapper
g Desktop

(Q proj_1 - ArcMap - Arcnfo. 'Elﬂg

‘ File Edit View Bookmarks Insert Selection Tools Window Help
DEHE % REX| o | & [f@2 Sl = |

||J =74 @ “ Edito;" 13 ‘ &~ Task ICreate New Feature __'_, ‘ Target: |FeatureCIass_1

b3

x|

B £ Layers
=] FeatureClass_1

A

O kroj

O M-34-64-D-d-4-2.tif

O M-34-64-D-d-2-4.tif

O M-34-64-D-d-4-1.tif

O M-34-64-D-d-2-3.tif

O M-34-64-D-d-2-1.tif

O M-34-64-D-b-4-3.tif

O M-34-64-D-b-3-4.tif
mozaika_kr_bufor300m.tif

foyc)

Menu 'i FeatureClass ~
[

V:\altad\szkolenie\dane'\zdj\RIM...

KA wK
K¥ AR

V:\altad\szkolenie\dane\zdj\RIM...

Vi\alta4\szkolenie\dane'zdj\RIM...

BunprEOorabites

V:\alttad\szkolenie\dane\zdj\RIM...

Display | Source | Selection | Map Book | <| i ] e o| , G ; : 7 i — i ol
| Drawing » K 3 & | O~ A~ < [0 il ~f0 < Bz u|A~ & 4~ o~ ‘
[_v [567889.923 249778.8 Meters

N

Gdy wiecej niz 1 zdjecie na danym miejscu
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Dodawanie zdjec bez georeferencji

Il Desktop
|1 DSH&| » =@~

o) Photm

Tools Window Help

lﬂ.' Rm J Edito;'l >

iJj Task: I Create New Feature

o o | |[i13% BiAE T=E01% [[on]c ¢ | =@ |

X
B £ Layers pa
o © EE

=] krakow_granica

O
= O arkusze_TOPO

O M-34-64-D-b-3
0 M-34-64-D-b-3
O M-34-64-D-b-3
O M-34-64-D-b-3
O M-34-64-D-b-4
O M-34-64-D-b-4
O M-34-64-D-b-4
[0 M-34-64-D-b-4
O M-34-64-D-d-1
O M-34-64-D-d-1
O M-34-64-D-d-1-—
O M-34-64-D-d-1
M-34-64-D-d-2
M-34-64-D-d-2
M-34-64-D-d-2
M-34-64-D-d-2
O M-34-64-D-d-3
1 [0 M-34-64-D-d-3 ™

m

FEEE e &

< | n »

Selection Map Book

o0

LS I
Kd A

i Wk B O

R

V:altad'\szkolenie\dane\zdj\zdj_K...

Open

Pan to

Zoom to
Identify

Add as annotations

Remove

H Drawing "T (=) &
i

DvAv:E“@AnaII ;]I'ID_v_IBIg‘Av&viv“Lv‘

ISAR2NN 802 247N74 Q4R Metere

Podglad jednego punktu
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Dodawanie zdjec bez georeferencji

CONSULTING

[ 0'] PhotoMapperlll = cx

P & DeSktop Tools Window Help
(DS E&| % @8 X| o | &[T ERITAroE 3=F 20 o+ |@®@|
‘ B Rm \ Edim[vi ~ ﬁj Task: [Create New Feature _'] ‘ Tafgrzt:l ZI |. II,-:E l JD } C] .:—'{ -"I ~I "( I. f:;- r;‘ [
lla <8 : % - \ ” L - <]
B £ layers “la [ Menu ~ | caly Krakow ~ e
=] caly_Krakow T &
ol 1 File » il AN :
= krakow_granica 53 I Edit » I Add symbols indicating direction =+
O & View » :
Add photos as annotations s
= O arkusze_TOPO ® Tools S - . 7 .
O M-3s-64-0-b-3 | [ dm [[[ v ° :
O M-34-64-D-b-3| || mp |[| @ OService
O M-34-64-D-b-3|= Na
O M-34-64-D-b-3
O M-34-64-D-b-4
O M-34-64-D-b-4| | || K
O M-34-64-D-b-4 0 V:\altad\szkolenie\dane\zdj\zdj_K... i
O M-34-64-D-b-4 M
O M-34-64-D-d-1
O M-34-64-D-d-1 xv
O M-34-64-D-d-1— é
O M-34-64-D-d-1 P
M-34-64-D-d-2 =
M-34-64-D-d-2 H
M-34-64-D-d-2 @ Vi\altad\szkolenie\dane\zdj\zdj_K...
M-34-64-D-d-2 i
O M-34-64-D-d-3
w0 M-34-64-D-d-3 7
< | 1 3
Display Source NN eV \ [ ||
Selection Map Book < i | ‘lam | u 4 ; : il o R
J Drawing 'ET’?T;' @ lg:{ A~ “i@kial L] Im l] B 7 U lA' v Iv o~
!7 [568737.025 242119.703 Meters 4

Podglad wielu punktow
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Zmiana potozenia punktu ﬁRENERPw

RO evese oo & o) o TR

ProCca

CONSULTING

v D e S kto p sols Window Help

Db &5 28X |0 | 1229
4 [éalj Edltor" >

EF-] o] :

2 M caly_Krakow

‘ = M krakow_granica

O
= O arkusze_TOPO

A_‘VJ Task: ICreat& New Feature

iﬂmN%®24ﬂﬁ%ltﬁéx:®®

Menu v caly Krakow ~

AER--aas ) O Ta

M-34-64-D-b-3
M-34-64-D-b-3
M-34-64-D-b-3
M-34-64-D-b-3
M-34-64-D-b-4
M-34-64-D-b-4
M-34-64-D-b-4
M-34-64-D-b-4
M-34-64-D-d-1
M-34-64-D-d-1
M-34-64-D-d-1'—
M-34-64-D-d-1
M-34-64-D-d-2
M-34-64-D-d-2
M-34-64-D-d-2
M-34-64-D-d-2
M-34-64-D-d-3
M-34-64-D-d-3 7

m

V:\altad\szkolenie\dane‘zdj\zdj_K...

I HHEEEEHNERERERERER

OO0 OOOO0O0O0O0O00000

" O |

| [569036.517 242091977 Meters

—

Zmiana potozenia, wielkosci i usuwanie obrazéw przy wykorzystaniu
narzedzia Select Element
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Kierunek fotografii TR

[ 0] PhotoMappe il =

IRl Desktop

ZH&E| s max

Tools Window Help

|

ENER ke

ELCNSPUICIMAENR IS 2

W[@J Editog" »

|x

iﬂ Vil ‘MEI«J §e$01&@‘f°@53 ::ﬁ)@\

=) £ layers -
= caly_Krakow

A

O caly_Krakow
=] krakow_granica

o

= O arkusze_TOPO

m

M-34-64-D-b-3-
M-34-64-D-b-3-
M-34-64-D-b-3-
M-34-64-D-b-3-
M-34-64-D-b-4-
M-34-64-D-b-4-
M-34-64-D-b-4-
M-34-64-D-b-4-
M-34-64-D-d-1-
M-34-64-D-d-1-
M-34-64-D-d-1-
M-34-64-D-d-1-
M-34-64-D-d-2-
M-34-64-D-d-2-
M-34-64-D-d-2-

M-34-64-D-d-2- ~
1] 3

I HHEHEEREEEENBEER

REREOOO0O00O0000O0

-~

Source
Map Book

Display
Selection

V:altad\szkolenie\dane\zdj\zdj_K...

V:altad\szkolenie\dane'\zdj\zdj_K...

o o | b [7225 B 1=F31%3 OERaET 1
i]j Task: ICreate New Feature j ‘ Tatqet:l L] |. Bl Il: J {:} o f ‘ " r[.‘ i | [
X BB

Menu v% caly_Krakow ~ \' s

e . P .
File > Y

| Edt  » | Add symbols indicating direction
View h Add photos as annotations
Tools »
Server >

@ Service

< | ] J

»

‘ Drawing v R (+) @il |g|:] A~ < “@ Avial

S =l B 7 u A~ & L~ o~ |

| [568692.287 242152187 Meters Y
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G EOles

Kierunek fotografii TRENER i

=)

"o-]PhotoMapper

r@ Cptions “ -
Bl Desktop

Import IThumbnaiI Cache |
—Include EXIF information
GPS I Image I Camera |

¥ Latitude [T Satellites

¥ Longitude [C DoP

W Altitude ™ Speed

¥ AltitudeRef

¥ Image Direction r ‘

¥ Image Direction Ref

—Extended import settings

% |se absclute path ‘ S,CIEZkI dOStepu
™ Use relative path

Ings direction

Walue for direction is selected automatically (default setting is compass;
if compass value iz 0, the movement direction is used).

Set to default = Save Cancel

Ustawienia importu z elektronicznego kompasu

Opcja Auto oznacza, ze informacja o kierunku jest odczytywana z kompasu elektronicznego.
Gdy kierunek = ,,0”, oznacza, ze albo zdjecie jest wykonane doktadnie na pdtnoc (azymut = 0),
albo nie posiada informacji o kierunku.

Wodwczas kierunek jest pobierany z kierunku ruchu.
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Zmiana/nadawanie kierunku fotografowania @rRENERrw

B e o3 o

ProCca

CONSULTING

m PhotoMappe I =

P Desktop ols Window Help 7
5 618 T 0 0 ¥ [ =T ERd |
4 [%E U EdltO['\ > lﬂJ Task: | Create New Feature = -

|x

== Layers -
=] caly_Krakow

A

O caly_Krakow
krakow_granica
0
O M-34-64-D-b-3-
O M-34-64-D-b-3-
O M-34-64-D-b-3-
O M-34-64-D-b-3-
[0 M-34-64-D-b-4-
O M-34-64-D-b-4-
O M-34-64-D-b-4-
O M-34-64-D-b-4-
M-34-64-D-d-1-
M-34-64-D-d-1-
M-34-64-D-d-1-—
M-34-64-D-d-1-
O M-34-64-D-d-2-
O M-34-64-D-d-2-
[0 M-34-64-D-d-2-
O M-34-64-D-d-2-
O M-34-64-D-d-3-
w [0 M-34-64-D-d-3- ~

Menu v caly Krakow ~

OO ST OTCTIG O TS Oy

m

igmwgwego‘;m%ltﬁﬁ:: ::.(D.@{

V:\altad\szkolenie \dane'\zdj‘zdj_|

V:haltad\szkolenie\dane'\zdj\zdj_| Rl

< [0 »
V:\altad\szkolenie\dane'\zdj\zdj_|
Display | Source
Selection |  Map Book Pl T »
\ Drawing 'Eriﬁ’?‘:;‘ i‘j 'Ej A~ < “@Mal l] |10 l] B I U A' &~ i' i ‘

| [565765.102 243206.723 Meters

Czy zdjecie ma prawidtowy kierunek?
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Zmiana/nadawanie kierunku fotografowania TRENER

ProCca

CONSULTING

PhotoMap per |- =i
Il Desktop oz Window. i

=3 = =1 %Eﬂn“ & |[13065 EaE T=Faa '
By [%E H sk ‘ICreate New Feature arget: ’ =14 A% ;
5 £ layers = Menu v caly Krakow ~

OO S IO O TS Oy

= M caly_Krakow

A

O caly_Krakow

krakow_granica
o
O M-34-64-D-b-3-
O M-34-64-D-b-3-
O M-34-64-D-b-3-
O M-34-64-D-b-3-
[0 M-34-64-D-b-4-
O M-34-64-D-b-4-
O M-34-64-D-b-4-
O M-34-64-D-b-4-
M-34-64-D-d-1-
M-34-64-D-d-1-
M-34-64-D-d-1-—
M-34-64-D-d-1-
O M-34-64-D-d-2- 2
O M-34-64-D-d-2- -

O M-34-64-D-d-2- | &1
O M-34-64-D-d-2- T
O M-34-64-D-d-3-

w O M-34-64-D-d-3- ~

m

W%h?@ﬂa%ltﬁ@xﬁ@@ﬂ

V:\altad\szkolenie\dane'zdj\zdj_|

V:\altad\szkolenie\dane'\zdj\zdj_|

< m »
V:\altad'\szkolenie\dane'zdj\zdj

Display | Source
Selection |  Map Book € [l »

‘ Drawing '[i¥ (=) o !EJ:I A~ X “@ Avial

| \p5765.102 2432064123 Meters

Zmiana kierunku
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ProGea

CONSULTING

Zmiana/nadawanie kierunku fotografowania

=&

=

;L'RENER

EPRR =S ey

' PhotoMapper Ll B+ ®oae” DOOO»

v S DeSktop ols Window Help
T Dua‘x EE] Ex‘”"‘\"}“?lﬂ% _]H

’ %04 [%ﬁ “ Editozvi |3 ‘ﬁj Task: ICreate New Feature

[

lgmw%xgoxﬁ%lfOQXﬁ@@

== Layers
= caly_Krakow

-

O caly_Krakow
krakow_granica
I| =o
O M-34-64-D-b-3-
' O M-34-64-D-b-3-
O M-34-64-D-b-3-
O M-34-64-D-b-3-
O M-34-64-D-b-4-
O M-34-64-D-b-4-
O M-34-64-D-b-4-
O M-34-64-D-b-4-
M-34-64-D-d-1-
M-34-64-D-d-1-
M-34-64-D-d-1-—
M-34-64-D-d-1-
O M-34-64-D-d-2-
O M-34-64-D-d-2-
O M-34-64-D-d-2-
O M-34-64-D-d-2-
] El M-34-64-D-d-3-
O M-34-64-D-d-3- ~
< \ [ »
Display l Source
Selecton | Map Book || < 3

II Drawing ¥ \ =) ig_-] lgj A v < “@ Avial

>

Menu - caly Krakow v

v oTOr oo orTeTor T

V:\altad\szkolenie\dane zdj‘\zdj |

hnia: asfaltowa

V:\altad\szkolenie\dane'\zdj\zdj_|

kc: szerokosc <3m

 [565692.931 242958.585 Meters
e

Zmiana kierunku
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Zmiana/nadawanie kierunku fotografowania TRENER

CONSULTING

"o-]PhotoMapper

:v S DeSktop Tools Window Help
[DSa& s 2@ |0 ElMET =R
4 @ |J Editoz'l > ‘ﬂj Task: ICreate New Feature _v] ‘ Ta;gg_:l LI ‘_;;' @)

[x

ERIROGBRINOL

X!

| GPS PhotoMapper N... []

Hjﬁ\:; ﬂzx@i 4

5 £ Layers A
= caly_Krakow

A

O caly_Krakow
krakow_granica
[ arkusze_TOPO
O M-34-64-D-b-3-
O M-34-64-D-b-3-
O M-34-64-D-b-3-
O M-34-64-D-b-3-
O M-34-64-D-b-4-
O M-34-64-D-b-4-
O M-34-64-D-b-4-
O M-34-64-D-b-4-
M-34-64-D-d-1-
M-34-64-D-d-1-
M-34-64-D-d-1-'—
M-34-64-D-d-1-
O M-34-64-D-d-2-
O M-34-64-D-d-2-
0O M-34-64-D-d-2-
O M-34-64-D-d-2-
m O M-34-64-D-d-3-
m [0 M-34-64-D-d-3- ~

< | u »

Display | Source
Selection | Map Book Pl T »

\_D_rawing'(ii‘:} 8 glj A~ < l@Arial _v_||1o L] B 7 U \Av & - ﬁv - ‘
= — - | [565572.636 243233.767 Meters

Widok po korekcji kierunku

Menu v caly_Krakow ~

AR~ T O o O Ty T

m

V:altad\szkolenie\dane'\zdj\zdj_K|

wWheZow

V:altad\szkolenie‘dane\zdj\zdj_K

£

|

V\altad\szkolenie dane'\zdj\zdj_K
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ProCca

G E Ol

Tworzenie raportow PDF JRENER%,,,

-

4L GPS PhotoMapper NG2 - pdf Photo-Reg

' o' JPhotoMapper

L ks

Feature-Class

Select the Feature-Class and check the attnbutes to
be shown in the photo report.
Flease note that you can change the order of the attributes.

Flease select a Festure-Class:

Icah,r_l{mkuw j
caty_Frakow
This Feature Class contains 27 features.
Attributes:

[C] OBJECT ID

e fle
|at
lon

|lat_ref
lon_ref

alt

[ alt_ref
img_dir
[] img_dirRef
[] date_org

Kolejnos¢ wyswietlania atrybutéow
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G E Ofes

Tworzenie raportow PDF oIRENERPw

25 GPS PhotoMapper NG2 - pdf Photo-Repa [ o"|PhotoMapper
— S |l Desktop
Templates NN
Select a template and a document title.
Please note: the available templates depend on the number
of selected attributes.
Template: Title:
1image per page caly_Krakow Create overview map page
1image per with detail
2 :magesppef ,‘;’f,'ge( ) Select features in overview map

2i images per page {with description)

V| Select feature in detail ma
nage (with descn ion and detz P

Selection color: =

~——

3images per page {with descnptlon)
4 images per page

 wybieramy wyglad dokumentu
e ustawiamy kolejnos¢ wyswietlania atrybutéw
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Tworzenie raportow PDF

— =

£
AL GPS PhotoMapper NG2 - pdf Phot -

' o"JPhotoMapper
S il Desktop

Photo des cipbions
Enter titel and description for the selected photos.

POFPHOTO-RFPORT

Title:
ul. Wielicka

Description:

El estakada -

Vialtad szkoleniedane adadj_Kr_
rozneRIMG0072.JPG

Vialtad szkolenie dane zdadj_K. .. |

<Back || Mext> | | Abort |

e ustawiamy tytut i opis zdjecia
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Tworzenie raportow PDF

ProGea

2 GPS PhotoMapper NG2 - ¢ [ o"]PhotoMapper
e Sl Desktop
Title page GPS

: Choose if  fitle page should be created.

PHOTO
MAPPER
|

Create title page

Logo: V:iatad'szkolenieNogo_ProGea_r Select image l

Titel:  Krakow - raport

Text
11-May-11

ProGGea Consulting

* ustawienie logo, tytutu, dodatkowych opiséw
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Tworzenie raportow PDF TRENER i

ProGea

CONSULTING

PhotoMapper
Desktop

RIMG0030.jpg (5) ( RIMG0070.3PG (2)

file: V:\alta4\szkolenie\dane\zdj\zdj_Kr_rozne\RIMG0030.jpg
lat:  50.083269
lon: 15.951781

lat_ref: N

lon_ref: E
ale: 216
img_dir: 192.2
OBJECT ID: 2
fle:
;50042106
n:  19.962325
at_ref:
fon_ref: E
alt 208

OBIJECT ID: 2 l
file: V:\altad\szkolenie\dane\zdj\zdj_Kr_rozne\RIMG0070.IPG
lat:  50.042106
lon: 19.962325 |
lat_ref: N |
lon_ref: E |
alt: 208 |
alt_ref: 0 |
|
l

. : 0
Ol | imgair: 2066

ef: M
: 2010:10:11 11:59:08

img_dir: 206.6

img_dirRef: M

date_org: 2010:10:11 11:59:08

obiekt: wiadukt drogowy |
droga: krajowa

material: zelbet I

Wyswietlanie automatycznych i wprowadzonych atrybutéw
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Tworzenie raportow PDF »IRENERV

ProGea

CONSULTING

PhotoMapper
t;j Desktop

IMG_2819.JPG (102) IMG_3014.JPG (126)

nazwa zdjecia: IMG_2819
opis: Zatopione domy w Toruniu. Kierunek NNW
miejscowosc: Torun
gmina: M.Torun
powiat: m.Torun
Gy Kuiawek &

dlugosc geografizna: 18°40'00"
szerokosc geografizna: 53°00°27"
wysokosc wykonania zdjecia: 628.2 m
kierunek: NNwW

konawca: Progea Consulting (fot. M. Ostrowski)
asciciel: ENERGA SA

nazwa zdjecia: IMG_3014

opis: Widok na zakole Wisly okolice miejscowosci Zlotoria. Kierunsk NW

miejscowosc: Zlotoria

gmina: M.Torun

powiat: m.Torun
ity ity

1 ki

dlulgosc geografizna: 18°42'21"
szerokosc geografizna: 52°59'39"
wysokosc wykonania zdjecia: 628.1 m
kierunek: NW
k a: Progea C Iting (fot. M. O: vski)
wiasciciel: ENERGA SA
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Tworzenie raportow PDF TRENER L

PhotoMapper
g Desktop

nazwa zdjecia: IMG_2819
Atrybuty opis: Zatopione domy w Toruniu. Kierunek NNW
. miejscowosc: Torun
OpPISOWE gmina: M.Torun
powiat: m.Torun
wojewodztwo: Kujawsko-pomorskie
dlugosc geograficzna: 18°40'00"
szerokosc geograficzna: 53°00'27"
wysokosc wykonania zdjecia: 628.2 m
kierunek: NNW
wykonawca: Progea Consulting (fot. M. Ostrowski)

Lokalizacja

Mozliwos¢ opracowania danych archiwalnych,
takze analogowych
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[} V4 A
Tworzenie ¢ladu GPS TRENER &

CONSULTING

| "o ]PhotoMapper
= Untitled - ArcMap - Arcinfo Y S Desktop

‘ File Edit View Bookmarks Insert Selection Tools Window Help

JDWHQ E‘wﬂk"nﬂ &+ |[1:100869 'i@\@ﬁﬂh\k‘?‘

| egtor =| > | 4 =] | Teret: | HAlx®aEa | e
3 x| =i -~
@ =
= £7 Layers
= 0zaiks Q
RGB o
MRed: Band_t e
[ Green: Band_2 L]
MM Blue: Band_3 s’;’
@
-
»
i
L3
o
[
& 4
2 Slad GPS
#
L2l
& 2 =
Display | Source Selectiun[ @O | &y |’|_
‘Qvawing'k'; ‘D'A'I'T:U@Alial L]|1n;]1111_1_4_v &v‘.._l-v“;v‘
GPS track import | |541203,446 181565,273 Meters
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) _, 0y
Tworzenie sladu GPS E,REN.ER,

Procca Ry ace o, 8 o) i MBI
[Consoiviing

"o ]PhotoMapper
Rl Desktop

% Untitled - ArcScene - Arcinfo

J File Edit View Bookmarks Selection Tools Window Help
D& 22X ¢ Eae&sn|w

J 3D Analyst vi Layer: [ stm_PL_bufftokm_oztf | 2 3 ‘

x|

o~ Q¢ Q4G6QQAEZOPEROM

=7 Scene layers
=] output_3D

= O srtm_PL_buff10km_92.tif
Value
High : 2622

I Low : -23

= mozaika-2010-06-27_bez-chn
RGB
BiRred: Band_t
[T Green: Band_2
.Blue: Band_3

< I |

Display -
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Integracja z dalmierzem laserowym «ERENERP::

e O

ProCca

CONSULTING

Wykorzystanie dostepnej w ArcGIS 10
operacji Bearing distance

€3 Bluetooth’
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I. ; _/'; 0}
ProGea

Zmiany dokonywane w GPS PhotoMapper sg zapisywane w pliku shp lub

Aktualizacja nagtowka zdjecia

geobazie. Istnieje mozliwos¢ zapisania zmian w pliku zdjecia.

"o-]PhotoMapper
Il Desktop

PE— e

i2| Attributes of in
FID | Shap} OBJ lat lon file lat_| | al ali_ret| img_dir | img_dir ate_org _name _value _nam —value _name WE -
2 | Point 1|50.053152 | 19.930749 | \akad\szkeleni [N |E 0 0 0 |:
1 PDint 2 500523_3‘( 1992599 V:\Ena4\52kuleni N E 400 0 = L1 20401 n-@ L= XX ) ﬂnn.r:n.h‘ Lo trol ju bn'ﬂjnllju ohbialt +|-u-|r |.'r||ﬂjr|lljﬂ if 1o L ol |’_
0 | Point 3 | 50.067716 | 19.950049 | Vattad\szkoleni | N E | 2181 0 122 (T 2011:05:10 18:47:34 transport dworzec obiekt dworzec podziemny | rodzaj tramwaj
1 | m | b
Record: ﬂjl i} jﬂ Show: I All - Selected | Records (0 out of 3 Selected) Options = |l?
Tabela atrybutéw przed wprowadzeniem zmian.
| Attributes of in =
OBJE | SHAP lat lon file lat_| lon al alt_ret| img_dir | imog_dir e_org _name _value _nam _value _name _value
» 1 | Point | 50.053543 | 19.930519 | V\altad\szkol| M E <Nulk= | <Mull= 77 | <Mull= <MNull= turystyka Wawel obiekt zamek <Mull= <Null= :J
2 | Point | 50.067716 | 19.95004% | V\atad\szkol| N E == A== ZiE=LE = ARETIRET = o & Faas =i = e
3 | Point | S0.082387 | 1992599 | Vakad\szkol| N E 108 0 2376 (M 2010:10:08 15:22:14 energetyka |trakcja kolejowa obigkt tory kolejowe ilosc torow |2

< |

1] |
Record: ﬂjl 1 ﬂﬂ Show: W Selected | Records (0 out of 3 Selected)

Options - |

Tabela atrybutéw po wprowadzeniu zmian. Catos¢ zapisana na razie jedynie
w geobazie.
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/4 )
( r_/f,’

oGea

Aktualizacja nagtowka zdjecia

Menu = | tvi0 - SR =] Trier
- M th

| File » [ ] NewShapefie Cirl4n .
Edit » Mew File Geodatabase f'

View 4 Add new Feature Class to existing File Geodatabase b

Tools » |5 OpenFeature Class Ctrl+0 .
. ) uf

Service 3
@ Import PhotoMapper 2.0 Feature Class v

N T T TR T
Einstellungen’abajramovi{

Add photos
Add photos from folder
Add unreferenced photos

Update Exif in image files

Il

Update Exif in Images

Feature-layer  test

IRl Desktop

 Irmage selection
&+ Al features
" Cumently selected feahures

— WTE ophong
' Copy into directory and update

Tanget directony: |

" Update existing images

S tart

Close I

/

J

Nadpisanie lub nowy plik
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G E Ofey

Integracja z ArcGlIS Server TRENER b

"o-]PhotoMapper
Il Desktop

menul: - '#] Connect (o Server \ Il &
T taczenie z serwerem
Fie 3 UAL: b dephotcmappersaver alad.localt
Tl |
Ciedertisk
Todls F B |
Server ¥ Je[Up Conrectlon [:E passkierd ==
@ Service ¢ Update Feature class
Ok Cancel
A& Feature dass bo map =
o
m =~

Menu - =
File »
Dodawanie do ArcGIS warstw z serwera.
Tools 3
Server » Setup Connection
@ Service > Update feature class
&dd Feature class to map
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PhotoMapper Server L%;T:_,B,EN«EWRE.

ProGea

=V
=1 \vver

g =
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CONSULTING

|
PhotoMapper Server TRENER \

... czyli zarzgdzanie, pozycjonowanie, wyszukiwanie
. > ver i udostepnianie zdjec
(ArcGIS Server)

Potezne narzedzie sieciowe:

dostepne dla uzytkownika na catym swiecie — Internet;
implementacja zdjec cyfrowych do GIS;
integracja zdjec z serwisami mapowymi;
tatwy i przyjazny interfejs;

doskonata organizacja duzych zbioréw zdjec:

o przechowywanie,
o wyszukiwanie,

o przegladanie,

O geopozycjonowanie.

Zarzadzenie i geolokalizacja dokumentacji fotograficznej 47



PhotoMapper Server

ProGea

CONSULTING

PhotoMapper Server:
e zintegrowane z ArcGIS Server (ESRI) narzedzie sieciowe
e dla uzytkownikow posiadajgcych duze zbiory zdjec cyfrowych

Umozliwia stworzenia wtasnego archiwum zdjec i zarzagdzanie nimi w dowolny sposodb:

e przechowywanie, przegladanie

» wyszukiwanie (przez Tagi, informacje opisowe, daty, poligony)

* dodawanie, udostepnianie i geopozycjonowanie (za pomocg mteraktywnej mapy cyfrowej).

% @ htp/photomeppersener.aitalcloud.com/= )48 Lln B

AAAAAAAA

te (@) (@) BE & sueenso [ magery T ropouss ] @ ] [Ltomn ]| oamoos (B
]
|
| |
o
wop )2
wer [
wap [ 1 4
e [
=] X
we Ol | -
e Il ®. o
w0 [ 15 RO Pl Noren O i 5
e L o Atlantic 5 o . P ’:—
wer [
we (7 || R 00 R 0 oo 1 i
.m[][
sao (1]
&
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| inder Karte zeigen | D’ . ./j
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- PhotoMapper Server TRENER 2
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CONSULTING

Wymagania:
* przegladarka internetowa z wtyczkami flash

™ Firefox — —

l &5 altad PhotoMapper Server Enterprise Edit.. I + r

% @ http //photomapperserver altadcloud.com/#

\& Search O

Search results: 0
System albums
Photo albums

=
a Add new album

‘-'—,"i‘ 10_las_igl_Babia {0)

g

| StreetMap

Imagery

{dj AAA_TEST_KIERUNEK_WYKONANIA (0}
r—"j Aleksander (7)
T
il BroTo (10
:'-"i‘ Babia Gora 2 {3)

ffd"} Bawaria (29)

? ‘;] inbox (443)

Image Inbox
usﬁmn

Show onmap [] . . .

(e)(=] EFEeE@EE O

[] An pictures "

[¥] current extent only

[[] current selection only

Sortby date: () File (&) Upload

Zarzadzenie i geolokalizacja dokumentacji fotograficznej 49



Dodawanie zdjec

ProCca

CONSULTING

J & altad PhotoMapper Server Enterprise Edit...| =+

€)% http://photomapperserver.altadcloud.com/#
% | S nitp/p PP

s 00 f(« JBIE s swww (o [wwe) €— Import zdjeé

Search results: 0
Upload pictures to the server

System albums

Photo albums

5 Add new atbum ® @ I

x
. b,
Photo upload % ﬂ Inbox (437) X
File Size Status Tries
Image Inbox

RIMGO165.1PG 2.4MB  uploading... 0
RIMGO168.1PG 2.2 MB | not processed 0 2
RIMGOL170.JPG 2.2 MB not processad (o] =
RIMGO171.1PG 2.3MB  not processed 0
RIMGO173.1PG 2.5MB | not processed 0
RIMGOL78.1PG 2.4 MB not processad [a]
RIMGO180.1PG 2.4 MB  not processed 0
RIMGO187.1PG 2.4MB | not processed 0
RIMGO188.1PG 2.5 MB not processed (0]
RIMGO130.1PG 2.5MB  not processed 0

- ﬁl::tifg_:h% I [ -4 ] Show on map |:] . . ./
Wybor zdjec Zdjecia zostaty umieszczone
w katalogu ,,Inbox”

Search results: 0
System albums Add new album
Photo albums
Alb : % Babia G 2
ﬁfi Add new album @ @ um name: # Babia Gora

Description: zdjecia z dnia 7.05.2011 r.

Tworzenie nowego albumu

[ Cancel ] [ Create ]
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ProGea

J @ altad PhotoMapper Server Enterprise Edit...

€ )2 % | @ http://photomapperserver.altadcloud.com/#

00gie

T }k =3 I Qs E"} e~ ‘ﬂ' _IVW‘IWBIHSKW" T ", 4 e, W O ":4"7\'_7' - N 2 T
‘% Search D@ o¢ L« ] Lo 3,‘ StreetMap TopoMap@
| P e e ruuwolzno 11 = i
rch results: —_ 2
| E40]
System albums @u ‘*\m
Photo albums
= I s D s
2l Inbox (435) e
Image Inbox ~TH . , . .
B lle zdje¢ znajduje

Przecigg/upusc

{e]l2) Showiof map|

Thumbnail bar content:
D All pictures

IZI Current extent only
D Current selection only

Sortby date: (O) File (&) Upload

®

sie w danym
obszarze

_F(_ — N
POWERED BY L®
&
& >
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ProGea

CONSULTING

Wyszukiwanie
zaawansowane

Wyszukiwanie

Funkcjonalnos¢

Pasek nawigaciji

Pasek narzedzi

Podglad pojedynczego
zdjecia

Autoryzacja

|

Lo

Wyniki
wyszukiwania

Syste
albumow

Album ——

A*uamo

RatEbAIry
& el ahe *

-5 ALY Yo A

Gl " Owbage Dapeew (22)

Podglad

(=)

& - e [
'“'-A'-l 7 “du
Gl e hacenas 0 we [

weo [

kd‘b“'

R

/7

o
- A bae

wybranych zdjec

& Tetagton Boves f we [
- e TN 4 (- D -
e baidrg (t we [
P Dresser $AB1Y AL Poopung (4 we [
Gl oo Gt e gt we [
- Rt ” we
Bl Fres enan we [
~ Mwee ratnge 1 we [ . o
= .‘v Poture Teken WYO008 20 W n
Selection 162 @ "'UO'."’.. ‘_Q" Upsend Due QAU 1113 N
o ﬁ’" Ongeal Merane  RIMOONS 2o
A \ > we Lt o rewmir
[ Largtse LRSS
Togn
) ol ) ® Wwenste® Q
w \“ * Potnier Jen [
;a i Q..,“ ® Wstor e Barmerd (-]
- B ) ) Straty | Commmerts
..& ® Sotw Dow, 11242000, 1512 be o
— 3 v,.-'” ortesrarTe
- - — ~ %
5 — : »r pach 4% ® Setw Do, 11282000, 1513 o
oo RRAERC o “ .
- - A, D Dotomar s or

Thmwrdansd 6. (onterd
L] - Pataes

—

Pasek zdje¢

] Curvern setacnon orey

oiyome O e @ wene (@
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g Albumy

Search results: 0
System albums |

& @, search
] mmeor 434 =l Search results: 0
ﬁ] Photos that are in no album {2}
7 System albums

ﬂ Not georeferenced photos [187)

Photo albums

i"{;j Add new album
Photo albums _ i“ ,a‘ BgPN (26)
Selection 0 @

a\ Czarna Hancza (353)

4 @] Fala kulminacyjna na Wisle (37)
Operacje prowadzone « %
L Bt umaeh ﬂ»uarwianskipmm

B s i D el
N Gmm—g W 0 ® 0
> ' [ v |

1 ] r‘" I
— @' Tmmmwe' © e
Pl
_._K.j‘.a._.'.. e ° ° ®

o~ ——

Powiekszenie do zasiegu
albumu

Powiekszenie do zasiegu
wszystkich zdjeé
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Geokodowanie zdjec

I._/" 0

ProGea

( 2al] Inbox (443) X |

Image Inbox

_ /7 Zdjecie bez geotagu

m K \ Zdjecie z geotagiem
i ShowonmapD @

System albums

=11 Inbox [443) Map
«l = Zdjecie bez geotagu w

osobnym katalogu

ﬂ Photos that are in no album (2}

ﬂ] Mot gecreferenced photos (193]

@ Not georeferenced photos (193)
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& Dodawanie zdjec

ProGea
4 |- .
&, search e KX BEw  tee «# Manual geocoding
Search Resufts: 0
Systam Albumns
@ View direction: not set
P o=
“‘, Paomc: o . D L I Y N I A A AN A AN A A R R I T D N A I Y N R B B |
.-‘;‘ Photoz That Arc In No Album [25] .Ir_l,
]| Photas Without Coordinates (233) - A i
[ Remove view direction ]
all Photos Withou Cooramates (202) x
Easting: 2217510.798398
@ . Map coordinates
Horthing: 5462869.572911
I

\\\

Longitude: 15.320238°

ol
— . WG 584
E Latitude: 50.095721°
al [ Easting: 2218260.84
Cursor coordinates
/ Northing: 6463051.11
]

@ [ Cancel ] [ Set ]
Przesuniecie zdjecia na
odpowiednig pozycje na mapie Ustawienie kierunku i doktadnego potozenia

7 . Lo S;r;aetMap iulr;;agery | TopOM;p ]7 7 @ @ Admin gotrWezyk '7

\ Kazimierz_k_Lutomierska_2.JPG V4 g X
e [ A
==Cr2h .

\J"{\’-{' <

Aleky | Modify coordinates / view direction

Modyfikacja
potozenia i kierunku

PhotoMapper Server
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CONSULTING

Tags

@ Krakow
@ tramwaj
@ dworzec

Comments

¢/ Babia Gora 2 (5)
' zdjecia z dnia 7.05.2011 r

Komentarze i tagi

Dla pojedynczych zdjeé

Comments
@ Piotr Wezyk, 51712011, T:42 h:

Add tag przystanek tramwajowy Dworzec Glowny Tunel

-
v

Dla catego albumu

Batch Tagging / Commenting: X
‘Enter Tagisk -

' Babia Gora

ponad lasem

Tags

@ partie okoloszczytowe
Comments

@ Piotr Wezyk, 5/17/2011, 8:59 h:

ponad lasem
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ol Wyszukiwanie

@% Search E]@
Q Advanced search @ Advanced search
D Filename: D Filename:
I:l Tags: |:| Tags:
|:| Comments: D Comments:

[] Title / Caption:

[] Title / Caption:
[+] Ricoh memao fields: (?) [Value] v’ Ricoh memo fields: ( pDV@
it I

([ picture taken: I~ 0 L[ picture taken: |+ ]

< A .
Wyswietlanie
|:| Restrict search results to current map |:| Restrict search results to current map
PN N\

wytacznie
Search re5|(ll5: 328 ) Search nta-sn(lls:!ilI ) y a‘

wyszukanych

Show on map |:| :q‘-': E

Photo: 11/24:2010 o
Upload:
11/25/2010

||||'1 b .
[]
2)
i
)

. 7 .
Photo: 11/24/2010 Photo: 11/24:2010 Photo: 11/24/2010 ZdJQC na maple

-~

Upload: Upload: 11/25/2010 f§ Upload: 11/2512010 | _
o o 112512010 =1
- . o
Photo: 1112472010 Photo: 11/M14/2010 Photo: 11/24/2010 Photo: 11/24/2010
Upload: Upload: Upload: 11/25/2010 Upload: 11/25/2010
1112612010 111182010

L

Photo: 1111472010 Photo: 11/14/2010 Photo: 1112412010 |8 Photo: 11/24/2010 |

i Upload: i Upload: Upload: 11/25/2010 Upload: 11/25/201 N\ Dodawanie do
(&)—

selekciji
drogi drogi o szerokosci ponad 20 m

ull
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\o J 7 ° °
il Wyswietlanie

StreetMap Imagery TopoMap ]
- —

[=PYWSET

Uruchamianie paska podgladu

Rozne style wysSwietlania

D All pictures
|ZI Current extent only

Current selection only

Sortby date: () File (3) Upload] ©

—\
reetMap TopoMap 2 @ Piotr Wezyk
2 P )

~ i ;
> RIMG0173pg Loy mEx

Wit3aczanie
miniatur
zdjec %
)
)
@ [click to ad caption]

H
&
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Zapis plikow

| A Mozliwos$¢ zapisania zdjecia na
=)D l ‘r\_rj http://photormapperserver,alt e C'H-'." Google }3] i E dySku Z Wszelkimi informacjami

Selection 3 2]
Kopiuj obrazek )
Kopiuj adres obrazka - n
Zapisz obrazek jako... \
Wysilij obrazek... :
Ustaw jako tapete... =3

Pokaz informacje o obrazku

% DownloadHelper » i @ hﬂ E] li

Thumbnail bar content: “ i' | Download pictures as zip-file I
—_— =211

Zapisanie pojedynczego zdjecia sabisinezdied z salbke

' 2 Fala kulminacyjna na Wisle (97)

' » | 2
L @ ® b @ _J
[ S ¥
\ Show on map D 'Ea

Zapisanie zdje¢ z albumu

| X
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Zastosowanie

CONSULTING

Inwentaryzacja Internetowe bazy danych Dokumentacja zdarzen

| rerer e

Pt

PhotoMepper Server Enterpse Edit
€« ® - statcioud.com Rt |

BhotoMapper Senver Enterprse £t

* & €2 (& atocoud.com BEIE ] 5llel B

R 08 o @)@ T & e (@ 5| Gamn))| remeriiE) N 0@ o (@)@ W & swoww [ O (o) e ot 08 o [@)(@) T & oo [@

RGO1E207 ) [F & o370 7 =8 Search : RGOS
System atums — < « '
Photo abums T —

‘Photo albums. ‘Photo aibums.

R e Q rerm

Gl Mt P Gl Aersmser

P & moonea &l moroven

Pt
P
& somen

Gl vacenzm Gl B oz

Pt Gl e

& ween & e

Pepr—— & cuama e ey Gl e 5

wazos, z2en

@ altot PhotoMapper Server Enterprise Ed.

. @/ aacloud.com:

& searc oe @I & o (@
ETr— .,

s

Search resulis:0 I
System sivoms System albums.
Photo aibums Photo atums. Photo slbums

@ raaremm B

Gl Revsansec) Gh Weksanser 1

&l mosa &l moronsy &l mornen

Gl acenze Gl s 0on 2 & ma ez

P o Pt

& soman & omen

G v oo Gl Crama v 083)

mans, ary

Te ke
e, asan

e O rie @ oot @
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Zastosowanie

CONSULTING

Kartowanie zbiorowisk roslinnych — Babia Géra
 babia_pr - Arcbap. 5
| File | Edit View Bookmarks Insert Selection Tools Window Help
e R e L R R T e L
@ @ @ |E B D G| @ B[00% ]| B | G | ceoreferencing v | Laer: [Water5o 221 ERra-1

o U Edito!'\ » ﬁj Task: ICreate New Feature _'] ‘ TarE(»‘:f.l L] ] < () ‘ | J g [ e (6 (O l Tl l 0o
IV 1., = :
= & lLayers u -] Babiaproj - | @

Babia_p|
O mozaike

= 2 [

KA uK
Ku AR

£
w
1

Kuba'‘konferencja_Zakopar

NEENEEEREEEEE B EE
NN RREERERRRER
Z
w

7

ERRN RS T RA-E-RE X T

Kuba'konferencja_Zakopari

M-34-8¢ M3_name M3_value M4_name
jaworzyna bardzo bujne runo do 100% pokrycia

strome zbocze = jaworzyna
k| jaworzyna

EEEEE
ooooo
2
®
-3

« [ 3 bujne runo widoczna pokrzywa, jerzyna i kopytnik

Display | Source jaworzyna na drzewie linia oddzialowa
Point Cloud Tasks Kuba'\konferencja_Zakopary rerowizko kornika
LAS Files

Selection | Map Book < [ » jaworzyna
— == Kosmatka olbrzymia
Drawing v | KN &) a@ ‘ O~ A~ I ‘ |0) Avial huba
rune ze starcem Fuchsa, lepieznikiem biabym

Skrzyp
goryczka trojesciowa
Szozyrtrwaly
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Zastosowanie Zﬂ;_REN.ER

ELCNEETFCIREERN I

CONSULTING

Klucze fotointerpretacyjne

Rozmieszczenie powierzchni prébnych y
- mapa rzegladowa A

Wyjazd 1
lipiec 2010r.

Wyjazd 2
sierpien 2010r.

LEGENDA

Wyjazd 3

" - p
powierzchnia pe wrzesien 2010r.

granica gminy

Mapa z pojedynczego wyjazdu
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Zastosowanie

ProGea

CONSULTING

B = classes
| 5@ inne
Q© Hale
(O Obszary piaszczyste
O skaty
@ Torfowiska
=-QO Pola
O Pola bez wegetacji
o ——— O Polaz wegetacja
= @ Teren zainwestowany

I at level 2 copy creating ‘level 3 above

y AL unclassified at level 3: woda
—————— I woda at level 3: copy creating ‘level 4 abov
{3 woda at level 4: grow into unclassified
e woda at level 4: merge region
Y4, woda with Area <= 50 Pxl at level 4: unclass
@ unclassified with Area <= 3 P at level d: er
2L woda with Area > 10000 Pl at level 4: cieki | =
%L, woda with Length\Width >= 2 at level4: ci
YL cieki, woda with Compactness < 2.5 at leve
YL cieki, woda with Length < 15 Pl at level d: |
%L unclassified with Existence of super objects
%4 unclassified with Existence of super objects |

! 1
1 1 @5
Di| [ Name Dislar
: 1 P — Rl
Pasentclss for iy Wodier
] : - @ Teren 5 =1 |[ 1 Shond - Aot T icive
QL T Use parent class coke
I 1 QL
1 1 @z A | o Cortained| %, Inherted|
1 | o T ; and (min)
1 1 5 @ Wody B Cloniotlsdes ooy
1 @ e A Mean pea_3
1 T nes
| A Raiadreen
I V\Rd:ﬂllﬂ
! 1 “« <> » G gnz NIR/RE_red  Process Tre
I\ RE_NIR/RE_t
1 1 = | "'t S » Kasyfikacja warstw tematycznych =
| | YL with OBJECTID: drogi > 0 at level 2: drogi
I ' B woda
\

3T delete level &'

Wspomaganie procesow decyzyjnych 3 e 4

na etapie klasyfikacji OBIA (ang. Object e

2L s0sna with OBJECTID: las > 0 at level 3:

m®

2L 20c lisciaste with Rel. border to fisciaste_
%L 20x: sosna with Rel. border to lisciaste_of

Based Image Analysis) i weryfikacji

2L 20x lsciaste with Rel. border to sosna_ol

%L sosna at level 3: sosna_ok

« m - »
« < »o\Main
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ProGea

@(ver

http://photomapperserver.altadcloud.com/#

-1
e 0 () (@)
FEE@EE =

http://www.altad.com

» Exif Extractor o] Exif
Extractor

o] PhotoMapper
IRl Desktop

» PhotoMapper Desktop
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ﬂRENER%

roCca = o

‘n Print Maps
B =
@ E

a m

Photos in
ArcGiIS for Desktop

Reports

Dziekuje
Za uwage

jakub.mlost@progea.pl
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